
RELEASE NOTES 

 

D9040DDRC DDR4 Compliance 

Test Application Software 
Keysight D9040DDRC Software Version 03.80.2.0 

Release Date:  April, 2023 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

11.50.00102 (UXR/MXR Series),  

06.73.00301 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.73.00301 (9000 Series) 

File Name: SetupInfDDR403800002.exe 

License: Please see the product data sheet on Keysight.com 

Modification 

- Update Keysight License Manager 5.
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Keysight D9040DDRC Software Version 03.80.0.0 

Release Date:  March, 2023 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

11.30.00406 (UXR/MXR Series),  

06.73.00301 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.73.00301 (9000 Series) 

File Name: SetupInfDDR403800000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Updated test references according to JESD 79-4D and JESD 209-4D specification. 

Defect fixes 

- Resolved issue where "Burst Length Limit" configuration under Eye Diagram Tests is not 

working as expected. 

- Resolved issue in Debug Tool where it unable to find Read/Write Burst Data successfully. 
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Keysight D9040DDRC Software Version 03.70.0.0 

Release Date:  October, 2021 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

11.30.00406 (UXR/MXR Series),  

06.70.00101 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.70.00101 (9000 Series) 

File Name: SetupInfDDR403700000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Support SW00DDRV License (DDR Validation license). 

Defect fixes 

- Resolved an issue with tDSS and tDSH tests, which would sometimes result in invalid 

negative value when running on Continuous DQS signal. 

- Resolved triggering issue when running eye diagram tests on UXR series oscilloscope. 

- Resolved reporting issue of several tests which would wrongly report information related to 

channel connected for other tests group. 

- Corrected default configuration values under “Signal Measurement Threshold Settings” to 

ensure compliance with values in the JEDEC specification. 

- Resolved overshoot/undershoot area calculation issue, which would produce overrated 

result in case the overshoot/undershoot width was shorter than XIncrement of the 

sampled acquisition. 
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Keysight D9040DDRC Software Version 03.60.0.0 

Release Date:  March, 2021 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.25.00902 (UXR Series),  

11.06.00401 (MXR Series), 

06.55.00504 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.55.00504 (9000 Series) 

File Name: SetupInfDDR403600000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added support for MXR-Series oscilloscopes. 

- Updated test references according to JESD 79-4C specification. 

- Updated DDR4 pre-amble and post-amble related tests methodology according to JESD 

79-4C specification. 

o tWPRE [Test ID:30111] 

o tWPRE2 [Test ID:30122] 

o tWPST [Test ID:30112] 

o tLZDQ [Test ID:30102] 

o tHZDQ [Test ID:30101] 

o tRPRE [Test ID:30113] 

o tRPRE2 [Test ID:30121] 

o tRPST [Test ID:30114] 

o tLZ(DQS_c) [Test ID:30125] 

o tHZ(DQS_t) [Test ID:30126]  

- Updated LPDDR4/LPDDR4X pre-amble and post-amble related tests methodology 

according to JESD 209-4C specification. 

o tWPRE [Test ID:50111] 

o tWPST [Test ID:50112] 

o tRPRE [Test ID:50113] 

o tRPST [Test ID:50114] 

o tWPRE [Test ID:60111] 

o tWPST [Test ID:60112] 

o tRPRE [Test ID:60113] 
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o tRPST [Test ID:60114] 

 

Defect fixes 

- Fixed issue of incorrect behavior for the "Write Preamble Pattern" setting that affects 

identification of the first edge in the write burst tests. 

- Fixed issue of incorrect test algorithm for the DDR4 tDQSH2PRE test. 

 

Modifications 

- DDR4 tjit(duty-high) [TestID:2100] and tjit(duty-low) [TestID:2150] tests have been 

removed from the compliance mode because these tests have been removed from the 

JESD79-4C specification. These tests are only available in custom mode. 

- Updated all the default values for the configuration settings under the "VIH/VIL for 

Command and Address" group according to DDR4 JESD79-4C specification. 

- Removed DDR4 tDQSS [Test ID:30106] test under 2tCK Write Preamble mode in order to 

be consistent with the JESD79-4C. 

- Added tDQSS2[Test ID:30127] test for 2tCK Write Preamble mode. 

- Removed tLZDQS [Test ID:30103] and tHZDQS [Test ID:30118] tests since these tests are 

no longer valid in JESD79-4C. 
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Keysight D9040DDRC Software Version 03.50.0.0 

Release Date:  August, 2020 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.20.00503 (UXR Series),  

06.55.00504 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.55.00504 (9000 Series) 

File Name: SetupInfDDR403500000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Implemented LPDDR4X Single-ended feature. 

- Implemented new Burst Trigger Method: MSOx Logic Triggering Feature for DDR4 test 

mode. 

- Implemented new “Auto Threshold" Threshold Mode that combines a clustering algorithm 

with a machine learning model to predict the correct thresholds for a given signal. 

- Updated test references according to JESD209-4C specification. 

 

Defect fixes 

- Resolved project loading issue where offline settings are not loaded properly. 

- Resolved the connection diagram issue for tDQ2DQ test regarding missing channel 

description for DQ Lane 2 signal. 

- Updated the test limit unit for DDR4 tDQS2DQ test according to JESD79-4B. 

- Fixed issue with additional reporting items for DDR4 SRIDiffR and SRIDiffF tests. 

- Support Bursty Clock for LPDDR4 Electrical test. 

- Resolved LPDDR4 Eye Diagram issue where it is not running properly under Preamble 

Pattern Mode when Rank Separation mode is enabled. 

- Resolved issue in the following LPDDR4X test which not running properly in Preamble 

Pattern mode. 

o VIHdiff_DQS (Test ID: 650501) 

o VILdiff_DQS (Test ID: 650502) 

o Vindiff_DQS (Test ID: 650503) 
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o Vindiff_DQS/2 Low Pulse (Test ID: 650505) 

o Vinse_DQS (Positive Pulse) (Test ID: 650506) 

o Vinse_DQS (Negative Pulse) (Test ID: 650507) 

o SRIdiffR for Strobe (Test ID: 650508) 

 

Modifications 

- Relocated VrefDC and VrefAC tests(Test ID 10398 & 10399) into custom test mode and 

change the limit type to InfoOnly. 
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Keysight D9040DDRC Software Version 03.20.2.0 

Release Date:  July, 2020 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.20.00503 (UXR Series),  

06.55.00504 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.55.00504 (9000 Series) 

File Name: SetupInfDDR403200002.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Support KSF-IPC 3.0 and cdm-protobuf 3.1 communication protocol for configuring and 

running tests using the Advanced Design System (ADS). 
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Keysight D9040DDRC Software Version 03.20.0.0 

Release Date:  April, 2020 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.20.00501 (UXR Series),  

06.50.01104 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.50.01104 (9000 Series) 

File Name: SetupInfDDR403200000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added Waveform Invert feature in the Tools menu (Tools>Infiniium>Channel Setup). 

- Added new tests for DDR4: 

o tERR(13per), tERR(14per), tERR(15per), tERR(16per), tERR(17per), tERR(18per) 

o srr2 

o srf2 

o tDQ2DQ 

o tWPRE2 

o tRPRE2 

o tDQS2DQ 

o tDVWp 

o VIHL(ac) 

o tDQSH2PRE 

o tIS(Vref) 

o tIH(Vref) 

o VIHDiffPeak 

o VILDiffPeak 

- Added new tests for LPDDR4: 

o tDQ2DQ 

o Write-Eye-Width 

o Write-Eye-Height 

o Read-Eye-Width 

o Read-Eye-Height 

 



 

 
Keysight D9040DDRC DDR4 Compliance Test Application Software Release Notes 10 / 48 

Defect fixes 

- Fixed issue where WFM file loading failed when using the new WFM format in Infiniium 

baseline version 10.20 and above. 

- Fixed issue where the Clock Timing tests used an incorrect configuration setting for the 

“Test Setup for: Data Strobe Timing and Data Timing ONLY” parameter. 

- Fixed issue where the Overshoot/Undershoot test was not running due to incorrect 

reference of the measurement threshold. 

- Fixed issue where the following tests considered an incorrect worst case value as the final 

test result. 

o Vindiff_DQS/2 Low Pulse 

o Vinse_DQS (Negative Pulse) 

o Vinse_DQS_Low(Strobe Minus) 

o Vinse_DQS_Low(Strobe Plus) 

- Fixed issue with screenshot for the following tests, where the Test App intermittently 

displayed waveforms from different acquisitions.  

o DDR4 

▪ VOH(AC) 

▪ VOH(DC) 

▪ VOHdiff(AC) 

▪ VOL(AC) 

▪ VOL(DC) 

▪ VOLdiff(AC) 

▪ VIHdiff.CK(AC) 

▪ VIHdiff.CK(DC) 

▪ VIHdiff.DQS(AC) 

▪ VIHdiff.DQS(DC) 

o LPDDR4 

▪ VOH(AC) 

▪ VOH(DC) 

▪ VOHdiff(AC) 

▪ VOL(AC) 

▪ VOL(DC) 

▪ VOLdiff(AC) 

 



 

 
11 / 48 Keysight D9040DDRC DDR4 Compliance Test Application Software Release Notes 

Known Defects/Missing Features 

- For certain versions of the Infiniium Baseline (such as v6.50.01004), the marker location, 

displayed on the reported screenshot, may be slightly offset in resolution by a few pixels. 

- On the connection diagram for the “Eye Diagram Tests” group, the channel specified for 

DQ lane 2 for ‘tDQ2DQ’ test is missing. As an alternative, you may refer to the configured 

value of “Data Lane 2 Source” parameter. 

- During DDR4 test runs on the Test App, you may observe an intermittent “Infiniium 

Disconnect” issue. 

- When the “Pre-amble Pattern” Burst Triggering Method option is used in the “LPDDR4X” 

test mode, the tests under the “Differential Input Level and Slew Rate For Strobe” test 

group may run incorrectly. 

 



 

 
Keysight D9040DDRC DDR4 Compliance Test Application Software Release Notes 12 / 48 

Keysight D9040DDRC Software Version 03.01.0014 

Release Date:  October, 2019 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.11.04711 (UXR Series),  

06.40.01101 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.40.01101 (9000 Series) 

File Name: SetupInfDDR403010014.exe 

License: Please see the product data sheet on Keysight.com 

 

Defect Fixes 

- Fix issue with LPDDR4/LPDDR4X tDQSCK test to cater for Static and Toggle pre-amble 

mode. 
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Keysight D9040DDRC Software Version 03.01.0013 

Release Date:  October, 2019 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.11.04711 (UXR Series),  

06.40.01101 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.40.01101 (9000 Series) 

File Name: SetupInfDDR403010013.exe 

License: Please see the product data sheet on Keysight.com 

 

Defect Fixes 

- Fix issue of wrong reported value of Overshoot/ Undershoot Area tests in LPDDR4. 
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Keysight D9040DDRC Software Version 03.01.0012 

Release Date:  July, 2019 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.10.04319 (UXR Series),  

06.40.00610 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.40.00610 (9000 Series) 

File Name: SetupInfDDR403010012.exe 

License: Please see the product data sheet on Keysight.com 

 

Defect Fixes 

- Resolved issue where the LPDDR4 feature is disabled when the (N6462A-1TP) license is 

available. 

Known Defects/Missing Features 

- No message will be prompted when user selected “Tools-> Infiniium -> InfiniiSim…” or 

“Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without installing the 

required license. 

- Rank separation feature will not work for eye diagram tests when using Preamble-Pattern 

separation method. 
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Keysight D9040DDRC Software Version 03.01.0011 

Release Date:  June, 2019 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.10.04319 (UXR Series),  

06.40.00610 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.40.00610 (9000 Series) 

File Name: SetupInfDDR403010011.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Updated the product number from “N6462A/N6462B” to “D9040DDRC” to support PPKS 

licenses. 

 

Defect Fixes 

- Resolved issue where the value of config “TopBase Level Vertical Scaling Evaluation Mode” 

is not used when the InfiniiSim feature is enabled. 

- Resolved issue of showing test group with empty test list when the SDRAM type is either 

LPDDR4 or LPRRD4X. 

- Resolved issue where error will be thrown when running a test trial where all the tests in 

the Strobe Plus Tests group or all the tests in the Strobe Minus Tests group are selected. 

- Resolved the issue where error will be thrown when running tQSH test. 

- Resolved marker placement issue on Vinse_DQS_High(Strobe Plus), 

Vinse_DQS_Low(Strobe Plus), Vinse_DQS_High(Strobe Minus) and Vinse_DQS_Low(Strobe 

Minus) tests. 

- Resolved the incorrect reported value for “Vcent” report item on tQW_total test. 

- Resolved issue of incorrect measurement result for tjit(CC) test when the Data Timing or 

Data Strobe Timing tests are run prior to running the tjit(CC) test. 

- Resolved issue of not disabling the InfiniiSim window in the screenshot for CA Eye diagram 

tests. 
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Known Defects/Missing Features 

- No message will be prompted when user selected “Tools-> Infiniium -> InfiniiSim…” or 

“Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without installing the 

required license. 

- Rank separation feature will not work for eye diagram tests when using Preamble-Pattern 

separation method. 
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Keysight N6462A/N6462B Software Version 03.00.0007 

Release Date:  March, 2019 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

10.00.04104 (UXR Series),  

06.30.00901 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.30.00901 (9000 Series) 

File Name: SetupInfDDR403000007.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Supports Infiniium Oscilloscope Software version 10.00.04104 for UXR-Series 

Oscilloscope. 

- Supports for configuring and running tests using the Advanced Design System (ADS) 2019 

Update 1 software. For more information, refer to the Memory Designer documentation in 

the ADS 2019 Update 1 User Guide. 

Modifications 

- Added option to select DQS Signal Type (‘Burst’ or ‘Continuous’) in Custom Test Mode. 

- Added user configuration “Waveform Source Name” to select the name of the waveform 

source for Clock Timing tests. 

Known Defects/Missing Features 

- When the SDRAM type is either LPDDR4 or LPRRD4X, and the DQS signal type is in 

“Continuous”, the test list excludes, “Eye-Diagram for Data and Data Strobe” tests, 

however the empty group will still present in the test list. 

- tDQS2DQ test may fail intermittently for certain signals, try rerun the test if this occurs. 

- Vinse_DQS_High/Low(Strobe) tests might abort when run together with VSEH/L(Strobe) in 

the same trial. If this occurs, run Vinse_DQS_High/Low(Strobe) tests separately. 

- In Offline mode, some test group headers in the ‘Select Tests’ will appear greyed-out. 

However, the tests within the test group are still available. 
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Defect fixes 

- Resolved issue where error occur when loading project file saved from UXR Series 

oscilloscope. 

- Improved Eye Diagram tests so that it will not hang when an invalid user defined Vcent 

value is entered. 

- Fixed issue where the user configs “Eye Diagram Vertical Top Level Scaling(V)” and “Eye 

Diagram Vertical Base Level Scaling(V)” did not set the scaling correctly. 

- Fixed issue where the user config “Eye Diagram Display Style” is not working correctly. 

- Resolved intermittent timeout issue for tCH Average High/Low measurement tests. 

- Fixed issue with Timing tests when Rank Separation mode is enabled. 

- Fixed tDVAC test where only one burst is measurement even specified to perform on 

multiple bursts. 

- Fixed Read timing tests not running in Debug Tool. 

- Resolved scaling issue for eye diagram tests when user entered user defined vertical scale 

while InfiniiSim turned on. 

- Fixed crash issue when running tests on non-US locale oscilloscope.  

- Resolved memory leakage issue when running tests in multiple trials thru remote 

automation. 

 

DDR4: 

- Fixed the incorrect signal source channel report item in the test report for VIX(DQS) test. 

 

LPDDR4/LPDDR4X: 

- Resolved issue with SRIN_cIVW test where measurement cannot be performed 

intermittently. 
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Keysight N6462A/N6462B Software Version 02.50.0000 

Release Date:  October, 2018 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

06.30.00701 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.30.00701 (9000 Series) 

File Name: SetupInfDDR402500000.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Split Overshoot/Undershoot (Clock) tests into Overshoot/Undershoot (Clock Plus) tests 

and Overshoot/Undershoot (Clock Minus) tests. In Offline mode, Overshoot/Undershoot 

(Clock Plus) test refer to the “Clock Plus” entry and Overshoot/Undershoot (Clock Minus) 

test refer to the “Clock Minus” entry. 

- Split Overshoot/Undershoot (Data, Strobe, Mask) tests into Overshoot/Undershoot (Strobe 

Plus) tests, Overshoot/Undershoot (Strobe Minus) tests, Overshoot/Undershoot (Data) 

tests and Overshoot/Undershoot (Data Mask) tests. In Offline mode, 

Overshoot/Undershoot (Strobe Plus) test refer to the “Strobe Plus” entry, 

Overshoot/Undershoot (Strobe Minus) test refer to the “Strobe Minus” entry, 

Overshoot/Undershoot(Data) test and Overshoot/Undershoot (Data Mask) refer to the 

“Data (DQ)/Data Mask (DM)” entry. 

- Enhancement of vertical scale on screenshot image when running Offline mode. 

- Added the Eye Diagram configuration parameter “Fixed Burst Length” in the Configure tab. 

 

Known Defects/Missing Features 

- Does NOT support backward compatibility due to change of test IDs. User will have to save 

previous project files as Settings Only before loading the project in the current software to 

access all the supported configurations. [File->Save Project (Settings Only) As...]. 

- SRIN_cIVW test intermittently returns invalid results on certain signals. Rerun the test if 

this occurs. 

- tjit(CC) Riding Edge Measurements test intermittently returns invalid results on certain 

signals. Rerun the test if this occurs. 

- The generated Clock Differential signal may be missing in the test report’s screenshot for 

Vix Clock tests in certain setup. 
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- Waveform window in the test report may appear smaller when marker/measurement 

window is turned on. 

 

Defect fixes 

- Fixed issues with the Offline mode, where application performed tests unexpectedly on the 

waveforms loaded earlier. 

- Fixed issues with Eye Diagram, which occurred when using the “Rank Separation” feature. 

- Fixed two issues with screenshots: 

o the captured image incorrectly showed the signal acquired during the previous test 

run. 

o the captured image had markers missing. 

- Fixed issue with the error prompt that appeared when performing offline tests using H5 

waveform files. 

- Fixed Application hanging issues during performing Clock tests, mainly when the 

connected signal had an amplitude lower than that configured for “VIH/VILdiff” parameter 

for Clock in the Configure tab. 

- Fixed issue with the SRIN_diVW test, where the Application performed this test in bubble 

state even when rank separation was enabled in the Configure tab. 

- Fixed issue with connection diagrams that were missing for tCH(abs) and tCL(abs) tests. 

- Fixed issue with loading of certain waveform files (in *.wfm format), which contained short 

acquisition. 

- Fixed issue with the remote interface, where the App allowed users to remotely enable 

LPDDR4 and LPDDR4X simultaneously. 

- Fixed missing tests in Offline Mode. 

 

DDR4: 

- Fixed issues with read eye diagram tests, where unexpected artefacts were found during 

eye folding. 

- Added appearance of DQS signal on screenshot for tLZDQ and tHZDQ tests. 

- Fixed issue with error prompt for VIX(DQS) test, which appeared when the signal did not 

contain read and write bursts. 

- Improved the time scale that appears on the screenshot for tCKE test, to include all 

reference CKE transitions. 

 

LPDDR4/ LPDDR4X: 

- Fixed issue with error prompt when running Clock Timing tests on a Bursty Clock. 
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- Fixed issue with results for Overshoot Area tests, where the Application returned invalid 

results despite valid crossing of the reference voltage (VDD or GND). 

- Updated the default configuration values for “VIHdiff.DQS_AC” and “VILdiff.DQS_AC” as 

per Table 96 of the JEDEC specification JESD79-4B. 

- Modified Application to completely hide the mask before performing “Vcent evaluation” 

when running Eye Diagram tests. 

- Added Bursty Clock support for following tests: 

o VIHdiff.CK(AC) [Test ID:  50411,60411] 

o VIHdiff.CK(DC) [Test ID:  50415,60415] 

o VILdiff.CK(AC) [Test ID:  50412,60412] 

o VILdiff.CK(DC) [Test ID:  50416,60416] 

o Vindiff_CK/2 High Pulse [Test ID:  50417,60417] 

o Vindiff_CK/2 Low Pulse [Test ID:  50418,60418] 

o Vinse_CK (Positive Pulse) [Test ID:  50419,60419] 

o Vinse_CK (Negative Pulse) [Test ID:  50420,60420] 

o Vix_CK_ratio [Test ID:  50381,60381] 

- Added configuration parameters “Read Postamble Pattern” and “Write Postamble Pattern” 

in the Configure tab to support extended Postamble mode. 

- Updated pass limits for tRPST and tWPST to use dynamic limits due to support for both 

standard and extended Postamble mode. 

- Added screenshot for SRIN_cIVW test results. 

- Added the following tests; 

o Vinse_DQS_Low(Strobe Minus) [Test ID:  50346,60346] 

o SRIdiffR for Clock [Test ID:  50422,60422] 

o SRIdiffF for Clock [Test ID:  50423,60423] 

o VIHdiff_DQS [Test ID:  50501,650501] 

o VILdiff_DQS [Test ID:  50502,650502] 

o Vindiff_DQS [Test ID:  50503,650503] 

o Vindiff_DQS/2 High Pulse [Test ID:  50504,650504] 

o Vindiff_DQS/2 Low Pulse [Test ID:  50505,650505] 

o Vinse_DQS (Positive Pulse) [Test ID:  50506,650506] 

o Vinse_DQS (Negative Pulse) [Test ID:  50507,650507] 

o SRIdiffR for Strobe [Test ID:  50508,650508] 

o SRIdiffF for Strobe [Test ID:  50509,650509] 
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Keysight N6462A/N6462B Software Version 02.30.0000 

Release Date:  March, 2018 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

06.10.01001 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.10.01001 (9000 Series) 

File Name: SetupInfDDR402300000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added support for LPDDR4X SDRAM type. 

Known Defects/Missing Features 

- Does NOT support backward compatibility. Project files saved in previous versions will be 

available as READ-ONLY. User have to save previous project files as Settings Only before 

loading the project in the current software to access all the supported configurations. 

[File->Save Project (Settings Only) As...]. 

Modifications 

- ‘Connect’ tab will fill the display screen during prompt for connection change. 

- Added configuration to select PUT for VIX(CK) tests. 

- Sort the remote configuration list accordance to dependency when query for the list of 

configurations remotely. 

- Fixed inconsistent display scale on the HTML test report for some of the Electrical Tests. 

- Fixed the error when ‘Top Base Ratio’ Threshold Mode is used along with ISIM.  

- Added ‘Screenshot Mode’ Configuration to disable screen capture for test report. 

- Fixed missing waveform in HTML report for VIHdiff.DQS tests. 

- Corrected typos in some of the user message dialog box. 

- Added ‘Auto Config Update’ configuration. 

- Added ‘Maximum Sampling Points (Pts) Clock Timing Tests Only’ configuration under 

Debug Mode. 
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DDR4: 

- Fixed missing eye diagram test mask file for speed grade 2933MT/s. 

- Fixed incorrect results value for VIX(DQS) test. 

- Updated the default threshold values in the configurations for CA signal. 

- Updated algorithm to look for center of the eye diagram to place the mask for Data and 

Data Strobe Eye Diagram Tests. 

- Relocated VSEH/VSEL for DQS tests to ‘Custom’ Test Mode. 

- Relocated tDVAC(Strobe) test into Write Timing Tests group. 

- Added ‘tIPW’ test. [Test ID: 30207]  

 

LPDDR4 

- Added ‘User Defined Vcent (CA)’ configuration. 

- Updated some of the report item’s names for vDIVW test. 

- Fixed intermittent incorrect measurement for  DQ VIHL(ac) test. 

- Updated Connection Diagram to include CS signal when Rank Separation is enabled for 

Eye Diagram Tests. 

- Added new tests: 

o Vindiff_CK [Test ID:  50421] 

o Vindiff_CK/2 High Pulse [Test ID: 50417] 

o Vindiff_CK/2 Low Pulse [Test ID: 50418] 

o Vinse_CK(Positive Pulse) [Test ID: 50419] 

o Vinse_CK (Negative Pulse) [Test ID: 50420] 

o Vinse_CK_High(Clock Plus) [Test ID: 50339] 

o Vinse_CK_Low(Clock Plus) [Test ID: 50340] 

o Vinse_CK_High(Clock Minus) [Test ID: 50341] 

o Vinse_CK_Low(Clock Minus) [Test ID: 50342] 

- Corrected typos in the test description for Vinse_CK_High(Clock Plus), 

Vinse_CK_Low(Clock Plus), Vinse_CK_High(Clock Minus) and Vinse_CK_Low(Clock Minus). 
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Keysight N6462A/N6462B Software Version 02.21.0000 

Release Date:  October, 2017 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

06.10.00616 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.10.00616 (9000 Series) 

File Name: SetupInfDDR402210000.exe 

License: Please see the product data sheet on Keysight.com 

 

Known Defects/Missing Features 

- Does NOT support backward compatibility. Project files saved in previous versions will be 

available as READ-ONLY. User have to save previous project files as Settings Only before 

loading the project in the current software to access all the supported configurations. 

[File->Save Project (Settings Only) As...]. 

Modifications 

- Updated Clock Timing Tests to prevent the “Not Enough Clock Edges for Measurement” 

error. 

- Added configuration options ‘Strobe Single-ended Voltage’ & ‘Clock Single-ended Voltage’ 

for ‘Single-ended Data Strobe’ and ‘Single-ended Clock’ tests, respectively. 

- Fixed not able to run Clocking Timing Tests with burst clock signals. 

- Fixed tWPRE incorrect measurement on certain signals. 

- Added user config ‘Minimum Burst Gap Width’ for Eye-Diagram Tests group. 

- Fixed inconsistent Test Mode option value in the generated test report header. 

- Fixed intermittent eye diagram reset when using Rd or Wrt ONLY as the burst triggering 

method. 

- Increased the acceptable latency value for config ‘READ Latency Value’ and ‘WRITE 

Latency Value’ under Eye-Diagram Tests group. 

- Added user config ‘Burst Identification Threshold [ISim]’ for each channel in Burst Trigger 

Threshold Settings group. 

- Updated SRIN_dIVW test to measure on the correct Write bursts. 

- Fixed intermittent ‘Input string was not in a correct format’ error. 

- Removed MSO related user configs. 
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- Fixed the issue where the burst triggering method is not updated after loading an existing 

project files. 

- Added a prompt to user when the SDRAM Type or Speed Grade options are changed. 

- Fixed the error when user enters the value ‘.xx’ instead of ‘0.xx’ into user config. 

- Fixed the intermittent issue where ‘UNDEFINED’ entry is added to non-editable user 

config. 

 

DDR4: 

- Updated to support JESD79-4B Specifications. 

- Updated VIX(CK) and VIX(DQS) tests algorithm. 

 

LPDDR4: 

- Updated to support JESD209-4B Specifications. 

- Updated tDSS and tDSH tests to perform on the correct edges. 

- Fixed incorrect folded eye diagram on certain signals when setting Preamble-Pattern as 

the burst triggering method. 

- Updated the method to find Vcent in eye diagram tests where the Vcent level 

intermittently misplaced if Read and Write bursts has significant different voltage level. 

- Updated vCIVW Margin test to measure the margin around the test mask. 

- Updated the result details in the test report for tQW_total and tQW_total_DBI tests. 

- Updated VIX_CK_ratio and VIX_DQS_ratio tests algorithm. 

- Updated DQ VIHL(ac) test algorithm. 

- Fixed SRIN_dIVW and tDIPW tests being performed incorrectly. 

- Fixed eye diagram for Write Eye Diagram test, where artifacts were removed from the 

folded eye that appeared for certain signals. 

- Added configuration options Padding for First DQ Bit under the Configure tab to manually 

set the number of DQ bits to pad/skip bits in the tDQS2DQ test. 

- Modified burst separation algorithm to support preamble pattern at a level lower than 

logic 0 level. 

- Modified configuration option Pre-amble Pattern Trigger Threshold under Configure tab to 

appear only when SDRAM type is selected as LPDDR4. 
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Keysight N6462A/N6462B Software Version 02.10.0005 

Release Date:  April 13, 2017 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

06.00.00628 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series, S-Series, V-Series), 

06.00.00628 (9000 Series) 

File Name: SetupInfDDR402100005.exe 

License: Please see the product data sheet on Keysight.com 

 

Known Defects/Missing Features 

- In some instances of the Application, opening a previously saved project file does not recall 

the value of the Burst Triggering Method option that was stored in the saved project file. 

As a workaround, start a new project [File->New Project…], followed by opening the saved 

project file. 

Modifications 

- DDR4 application migration to 64-bit platform. 

- Config ‘Minimum Data Amplitude’ minimum valid range changed from 0.1 to 0.01. 

- Fixed the issue where the Burst Triggering Method intermittently goes blank. 

- Fixed the issue where some Data and Data Strobe eye diagram tests are not able to run. 

 

DDR4: 

- Added/updated tests: 

In Compliance Mode: 

o tDIVW Margin [Test ID: 20403] 

o vDIVW Margin [Test ID: 20404] 

In Custom Mode: 

o tDIVW [Test ID: 120403] 

o vDIVW [Test ID: 120404] 

 

- Corrected the test limit of overshoot/undershoot (Address, Control) tests. 
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LPDDR4: 

- Added/updated tests: 

In Compliance Mode: 

o tDIVW Margin [Test ID: 50403] 

o vDIVW Margin [Test ID: 50404] 

o tCIVW Margin [Test ID: 30400] 

o vCIVW Margin [Test ID: 30402] 

In Custom Mode: 

o tDIVW [Test ID: 150403] 

o vDIVW [Test ID: 150404] 

o tCIVW [Test ID: 130400] 

o vCIVW [Test ID: 130402] 

 

- Updated tDIVW test to report results in UI. 

- Fixed the issue where Differential AC Read tests where intermittent fail on certain signals. 

- Updated connection diagram to show the channel DQS+ and DQS- used for VSEH/VSEL 

tests when Preamble Pattern burst triggering method is used. 
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Keysight N6462A/N6462B Software Version 02.00.0004 

Release Date:  February 15, 2017 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.75.00214 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.75.00214 (9000 Series) 

File Name: SetupInfDDR402000004.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Updated all the measurement reporting items to use consistent property format. 

 

Known Defects/Missing Features 

- In certain cases, it is possible that application is unable to upload some available 

measurement results to the repository.  This is generally caused by some session login 

issue.  Performing a logout in the current session and then re-login to a new session will 

resolve this issue. 
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Keysight N6462A/N6462B Software Version 02.00.0003 

Release Date:  February 10, 2017 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.75.00214 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.75.00214 (9000 Series) 

File Name: SetupInfDDR402000003.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added support for new export to repository feature where user can export test results to a 

repository (such as a database). [File->Export Results…->Repository] 

 

Modifications 

- Minimize InfiniiSim window when capturing screen shot for the test report. 

- Does NOT support backward compatibility. Project files saved in previous versions will be 

available as READ-ONLY. User have to save previous project files as Settings Only before 

loading the project in the current software to access all the supported configurations. 

[File->Save Project (Settings Only) As...] 

- Migrated application to use new graphics user interface environment. 

- Fixed issue of “index out of range” that occur on VSEH/VSEL for Strobe Plus and 

VSEH/VSEL for Strobe Minus. 

- Fixed some missing test issue that should be available in offline mode. 

- Enhance the marker presentation for all differential input cross point tests by locating the 

measurement reference level. 

- Added report item on all differential input cross point tests to report the value of 

measurement reference level. 

- Fixed issue for “DQS-DQ Phase Difference” Burst Trigger Method which incorrectly find 

Read and Write burst for some unique case. 

 

LPDDR4: 

- Fixed tWPST & tRPST tests where these tests are not able to run on certain signals. 
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- Fixed tDQSCK test measurement behavior. 

- Fixed typo in the measurement items for tCIPW test. 

- Minimize the mask region when performing DQ VIHL(ac) test. 

 

DDR4: 

- Enhanced preamble and postamble tests. 

- Fixed missing duplicate measurement items in report for SRIN_diVW test. 

- Fixed tDIPW test where it is available in offline mode where it should not be.  

- Enhancement to the error message for tIS(base), tIH(base) & tCKE tests. 

- Fixed issue of “index out of range” that occur on DDR4 Overshoot/Undershoot Clock tests. 
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Keysight N6462A/N6462B Software Version 01.17.0000 

Release Date:  December 06, 2016 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.70.00901 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.70.00901 (9000 Series) 

File Name: SetupInfDDR401170000.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Updated Method of Implementation (MOI) document. 

- Fixed the issue where the Read Write Separation not able to run on Infiniium Software 

version 5.70 above. 

- Fixed unexpected refresh of configuration issue when Burst Triggering Method is changed. 

- Fixed unexpected refresh of Custom Data Rate issue when Burst Triggering Method is 

changed. 

- Fixed ‘Out of Memory’ issue which happens when processing signal that have enormous 

number of invalid bursts. 

- Fixed the instances where error message is prompted even after the number of waveforms 

acquired is achieved in eye diagram tests. 

 

LPDDR4: 

- Updated the ratios used to extrapolate tHZ_EndPoint & tLZ_EndPoint in tWPRE and 

tWPST tests. 

- Fixed eye diagram tests not able to perform when using Preamble Pattern separation on 

certain signals. 

- Fixed CA VIHL(ac) test not able to run individually. 

- Fixed tDQS2DQ test where it is not able to find the first eye opening even it is still within 

the compliance range. 

- Fixed the issue where test measurement results are not reported for tQW_total test. 

- Fixed tDIPW test not able to run with certain InfiniiSim files. 

- Fixed Vix_CK_ratio test where this test unexpectedly prompt error message “Index out of 

range”. 
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- Fixed Vix_DQS_Ratio report item issue where one of the report items “VdiffDQS pk-pk” 

unexpectedly report bogus value. 

- Fixed VSEH/VSEL Strobe Plus/Minus tests which not able to run properly on offline mode. 

- Increase acquisition length for clock tests to avoid the case where the number of cycle 

captured is less than 200 cycles, which is requirement for tCK(avg) and other average 

clock timing measurements. 

- Fixed Vix_CK_ratio test which prompt error message after processing very low amplitude 

clock signal. 

(cont.) 

 

DDR4: 

- Correction of SRIdiffR/SRIdiffF test implementation which supposed to be performed on 

Write burst. 

- Add missing specification limit for VREF(DC) Measurement. 

- Fixed VIX(CK) test which prompt error message after processing very low amplitude of 

clock signal. 
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Keysight N6462A/N6462B Software Version 01.16.9071 (BETA) 

Release Date:  September 29, 2016 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.50.0030 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.50.0030 (9000 Series) 

File Name: SetupInfDDR401169071.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Updated on waveform file loading to support test running on Infiniium Software version 

5.70.00713 and above. 

 

LPDDR4: 

- Fixed tDQS2DQ test where it is not able to recover a clock. 

- Fixed tRPRE test where the start location of the measurement is incorrect. 

- Fixed tjit(CC) issue where this test always report maximum result case as worst result 

instead of considering both maximum and minimum result. 

- Updated tWPRE test limit. 

 

DDR4: 

- Updated measurement for 2T clocking method for tIS(base) test. 

- Updated measurement results and test limit for tDIPW test. 

- Fixed Vref Measurement test where this test not fully perform as expected in JEDEC 

specification. This issue is resolved by creating two tests: VREF(DC) Measurement and 

VREF(AC) Measurement. These two tests replace the previous Vref Measurement test. 
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Keysight N6462A/N6462B Software Version 01.16.9063 (BETA) 

Release Date:  August 16, 2016 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.50.0030 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.50.0030 (9000 Series) 

File Name: SetupInfDDR401169063.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

N/A 

 

LPDDR4: 

- The test name ‘tCIVW’ has been changed to ‘tCIVW Margin’. The test will now report 

margin between the mask and eye diagram in terms of percentage. 

Known Issues 

- In loading projects created in previous versions, users cannot append the existing results. 
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Keysight N6462A/N6462B Software Version 01.16.9062 (BETA) 

Release Date:  July 22, 2016 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.50.0030 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.50.0030 (9000 Series) 

File Name: SetupInfDDR401169062.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- The order of the test sequence GUI under the “Select Tests” tab has been updated. 

 

DDR4: 

- Updated the options for “Burst Triggering Method” under DDR4 test mode where the 

“MSOx Logic Triggering” choice has been removed. 

- Updated tjitCC test where the worst-case value now considers absolute value of min/max, 

instead of just -ve value. 
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Keysight N6462A/N6462B Software Version 01.16.9058 (BETA) 

Release Date:  July 01, 2016 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.50.0030 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.50.0030 (9000 Series) 

File Name: SetupInfDDR401169058.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

DDR4: 

- Fixed HDF5 File library output handling for DDR4 Debug Tool. 

- Fixed tDIPW test to use Vcent instead of Vref. 

- Fixed file format to automatically change AC Level parameters when value is changed from 

the Setup screen. 

- Fixed Eye Mask position by replacing Vmax and Vmin with Vtop and Vbase respectively. 

- Fixed tDIVW mask margin failure false result by adding percentage (%) unit to tDIVW 

Margin and vDIVW Margin test. 

- Fixed the VTLow input parameter used when running the tDIPW test under the Preamble 

Read/Write Separation method. 

- Fixed DDR4 VIX(DQS) to produce valid results for valid write burst measurements in VIX 

DQS test. 

- Removed all duplicate entries from the DDR4 Test Limit File. 

- Added DataRate value to properly scale the DDR4 VIX CK test result display. 

- Added Min/Max instead of VTop/VBase in the Read/Write Separation method for the 

threshold values. 

- Added ReadWriteOnly Triggering method. 

- Updated Worst Undershoot Amplitude limits as per JEDEC Committee Letter Ballot Item # 

JC-16-180.24, Table 7, to report the measurement values. 

- Included Associate Signal for DQS and new zoomed out screen to observe the worst 

location in a broader view (larger time range) for Overshoot. 

- Fixed the DDR4 Debug Tool to remove the ‘DDRUDFapp has stopped working’ error. 
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- Added tCK(abs), tCH(abs), tCL(abs), VIX(DQS), tDSS, tDSH, tDQSQ_DBI, tQH_DBI, 

SRIN_dIVW, SRIdiffR and SRIdiffF to complete the DDR4 list of tests as per JESD79-4A. 

- Modified the Histogram Vref to use the VrefDQ value from the Configure tab of the 

application to fix the RX Mask placement issues observed at lower frequencies (547MHz). 

- Modified the Read or Write ONLY UDF method to cater for 200MT/s and 300MT/s signals 

with fast falling edge to fold eye diagram. 

- Modified VIH/VIL DC to the correct value to fix configuration value of DC75. Updated 

Threshold Configuration Wizard to use DC75. 

- Fixed automatic update of the tDIVW compliance value in Configure tab for custom speed 

grade mode to align Marker X2 with left edge of the mask. 

- Fixed Application Crashing issue when running compliance tests with invalid ‘Custom Data 

Rate’. 

- Added a new configuration for the electrical test, so that it displays different sizes in the 

data bit. 

-  Replaced “DDR3” with “DDR4/DDR3” for Write Preamble pattern to include DDR4.  

- Modified the Custom Data Rate text box to disable and enable the “Change Setting” 

button visibility, by default. 

- Fixed loading of correct difference mask file with respect to the Speed Grade selected. 

- Fixed issue with running the Clock and Eye diagram tests when InfiniiSim mode is enabled. 

- Fixed tCIPW and tDQSQ_DBI tests. 

- Fixed the Overshoot Amplitude/Area hanging issue. 

- Fixed overlap processing issue that set tDIPW result = 0s due to very short burst distance 

between bursts. 

- Replaced VrefDQ with VrefCA to define pulse start and end in Overshoot/Undershoot 

(clock) tests. 

- Fixed default configuration values for VIH/VILdiff. 

- Fixed issues related to Overshoot/Undershoot tests, test results and area measurements. 

- Updated threshold values for VSEH/VSEL Strobe: 0.5VDDQ+-AclevelDQ and for 

VSEH/VSEL Clock: 0.5VDD+-AclevelCA. 

- Modified Sampling Points to use custom defined values when folding an eye diagram.  

 

LPDDR4: 

- Modified tCK(abs) test to always report minimum value. 

- Fixed tWPRE measurement by correcting histogram window to perform tLZDQS 

measurement. 
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- Fixed issues with VSEH/VSEL tests by using another pair of DQS+/DQS- for Preamble 

Read/Write Separation method and single-ended DQS for other Read/Write Separation 

methods. 

- Added a comment on DQS rising edge for tDSS and tDSH to indicate that tDSS and tDSH 

performs on DQS falling edges only. 

- Fixed LPDDR4 VIX_DQS_Ratio to produce valid results for valid write burst measurements 

in VIX DQS test. 

- Changed the Preamble and Read/Write Only Separation method for tWRPE 

measurements. 

- Added DataRate value to properly scale the LPDDR4 VIX CK test result display. 

- Added Read/Write Separation Timeout, with a default value of 3 minutes, to find valid 

Read Burst. 

- Implemented new Read/Write Separation method. 

- Fixed HTML Report GUI from displaying Speed Grade in Custom Mode. 

- Updated the test steps for tCH(Abs), tCH(Avg), tCK(avg), tCH/tCL Average High 

Measurements to use only the LPDDR4 test step as prerequisite to prevent from reporting 

the same limit values. 

- Convert the resulting value from seconds to UI, then change the unit to fix tQW_total 

wrong units and wrong values. 

- Fixed tDQSS and tDQSH markers to measure values from DQS signal to Clk signal and not 

the other way round. 

- Added the test limit in all LPDDR4 related limit files to fix limits that were missing in DDR4-

2400. 

- Fixed test limits for all LPDDR4 tests according to JEDEC specification JESD209-4A. 

- Modified the Preamble pattern for the FIRST and LAST bursts, for both Read and Write 

bursts to fix the issue of wrong start of the burst for eye diagram measurement in tWPRE 

tests. 

- Fixed Vcivw test runs. 

- Fixed values of Vcivw according to the JEDEC specification and is determined based on 

the selected Speed Grade. For custom speed, the speed rate associates with the next 

higher speed grade. 

- Fixed mask placement issues for tCIVW and vCIVW test at 547MHz (Low Speed). Updated 

test limits and measurement result units for all speeds in tCIVW tests, according to the 

JEDEC specification. 

- Updated Threshold Settings Wizard and fixed test limit issues for VOH(DC) and VOL(DC) 

tests, such that the values change dynamically according to the "VDDQ" option in 

“Configure” tab. 
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- Removed VIHdiff_min and VILdiff_max configuration options. The default configuration 

values for VIHdiff.CK and VILdiff.CK is derived from the JEDEC Specifications. 

- Fixed implementation code for tCH/tCL(avg) and tCH/tCL(abs) tests. 

- Updated threshold values for VSEH/VSEL Strobe: 0.5VDDQ+-VIH/VILDiff_DQS and for 

VSEH/VSEL Clock: 0.5VDD2+-VIH/VILDiff_CLK. 

- Modified User Configuration Setup Wizard GUI for Supply & Reference Voltage to conform 

with JEDEC specification JESD209-4A. Modifications include removal of Set button, 

removal of VTT [V] field, replacing VDD [V] with VDD1[V] and VDD2[V]. 
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Keysight N6462A/N6462B Software Version 01.16.0000 

Release Date:  October 16, 2015 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

5.50.0030 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.50.0030 (9000 Series) 

File Name: SetupInfDDR401160000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added LPDDR4 Debug Tool features. 

- Added tCH and tCL tests in offline mode. 

 

Modifications 

DDR4: 

- Solved the waveform misplacement after the test completed. 

- Solved the cancel button in the browse form not working correctly for offline setup. 

- Solved the debug tool memory leak issues. 

- Solved the undershoot area test error. 

- Added sampling point or memory depth configuration for eye diagram tests. 

- Added vertical scaling configuration for eye diagram test. 

- Added write preamble pattern configuration. 

- Split each of the VSEH (DQS), VSEL (DQS), VSEH (CLK) and VSEL (CLK) tests into two 

categories which are VSEH Plus (DQS), VSEL Plus (DQS), VSEH Plus (CLK), VSEL Plus 

(CLK), VSEH Minus (DQS), VSEL Minus (DQS), VSEH Minus (CLK) and VSEL Minus (CLK) 

tests. 

- Solved the VSEH Plus (DQS), VSEL Plus (DQS), VSEH Plus (CLK), VSEL Plus (CLK), VSEH 

Minus (DQS), VSEL Minus (DQS), VSEH Minus (CLK) and VSEL Minus (CLK) Compliance 

App Uses Wrong Offline Data. 

- Added test limit for tCK(avg) tests" by add ReportMeasStep on the report, display Note 

that "Please refer to the JEDEC specification for actual limit". 
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- Added code to validate on the custom data rate text box in the setup tab of the 

compliance application. 

- Update the entire connection diagram to show Keysight brand oscilloscope instead of 

Agilent oscilloscope. 

- Solved the VSEH and VSEL test for Strobe Minus configuration cannot be two identical 

input channels. 

- Solved the overshoot CA and overshoot Clock tests using the wrong reference voltage. 

 

LPDDR4: 

- Solved the issues where the vCIVW measured double of the mask size. 

- Solved the tDIVW and vDIVW tests used the wrong mask file. 

- Hide the command address tests which should not existed in the offline setup mode. 

- Solved the limit file did not update according to the SpeedGrade of 4266MHz. 

- Solved the connection diagram issues for the eye diagram test which show three channels 

(including Clock signal) are needed for the test. 

- Added read preamble pattern configuration. 

Enhancement 

DDR4: 

- Update AcDclevel and derating table to follow latest DDR specification. 

- Updated the limit file for the VSEH minus clock and Strobe tests. 

- Updated the test limit for the VIX clock and VIX DQS. 

- Update the tCIPW test to mentioned that the UI  unit is equal to the tCK avg min. 

 

LPDDR4 Debug Tool: 

- Added electrical test to the debug tool. 

- Disable and minimize the GUI while the debug tool is on. 

- Added a function to transfer configurations value from compliance application to debug 

tool or vice-versa. 

- Added function to plot the single eye diagram or multiple eye diagrams in debug tool. 
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Keysight N6462A/N6462B Software Version 01.15.0000 

Release Date:  January 30, 2015 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401150000.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

DDR4 : 

- Solved tWPRE test vertical scalling issues at HTML report. 

- Solved tDVIW test and vDIVW test missing unit in result tab. 

- Solved Overshoot/Undershoot Clock tests do not show up in offline mode. 

- Solved the clock tests failed to trigger with small amplitude. 

- Updated the VrefCA, VIH.CA(ac), VIL.CA(ac), VIH.CA(dc) and VIL.CA(dc) default values in 

configure tab as stated in latest specification. 

- Updated the Overshoot/Undershoot Data tests methodology to perform Tmax/Tmin for 

entire acquisition instead of some defined window. 

 

LPDDR4 : 

- Solved tQW test with no mask height. 

- Solved tWPRE test not measuring two clock cycle on DQS for DQS-DQ phase difference 

and Wrt or Rd Only burst trigger method. 

- Changed on the license to enable LPDDR4 feature by just using the (N6462A-1TP) license 

instead of (N6462A-2TP) license. 

 

Enhancement 

– Speed up the tests run time while the InfiniiSim is turn on. 
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Keysight N6462A/N6462B Software Version 01.14.0000 

Release Date:  December 17, 2014 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401140000.exe 

License: Please see the product data sheet on Keysight.com 

 

New Features 

- Added LPDDR4 features. 

Modifications 

- Solved the Eye Diagram tests and Clock tests failed to run while the InfiniiSim features in 

the Application is turn on. 

- Solved the issue that happen when large InfiniiSim transfer functions is used whereby it 

take too long test run due to loading it multiple times. 

- Solved the tWPRE issue. 

- Solved the offline clock test. 

- Added Vref measurement source. 

Enhancement 

- Updated the tWPRE and tDSS tests methodology. 
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Keysight N6462A/N6462B Software Version 01.13.0001 

Release Date:  October 17, 2014 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401130001.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Solved the Environment Variables used in Application should refer to the Keysight path 

instead of Agilent path. 

 

Keysight N6462A/N6462B Software Version 01.13 

Release Date:  October 03, 2014 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401130000.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Solved the VIX clock test where it always shown “Unable to find valid transition” 

annotation notes. Although, there is a valid result shows on the oscilloscope. 

- Solved Acquisition Setup for the application that did not work correctly in debug mode. 

- Solved the test result signal did not appear at the result tab and HTML report after finished 

run the test in Infiniium Software 5.20++. 
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Enhancements 

- Supports for Infiniium Oscilloscope Software version 5.20 

 

Agilent N6462A/N6462B Software Version 01.12 

Release Date:  September 19, 2014 

Requirements Category  

(e.g., operating system): 

Microsoft Windows 7 

Requirements Category  

(e.g., instrument software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401120000.exe 

License: Please see the product data sheet on Keysight.com 

 

Miscellaneous Notes 

- Added script in the build package to check the Mathworks Compiler Runtime0715 (32 bit) 

is installed or not. 

 

Agilent N6462A/N6462B Software Version 01.11 

Release Date: August 15, 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401110000.exe 

License: Please see the product data sheet on Keysight.com 

New Features 

- Added variables such as OfflineClockFilePath, OfflineDQSFilePath, OfflineDQFilePath, 

OfflineCSFilePath, OfflineCAFilePath, OfflineDQSPlusFilePath, OfflineDQSMinusFilePath, 

OfflineClockPlusFilePath and OfflineClockMinusFilePath to support remote programing. 
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Modifications 

- Solve the Eye Diagram test where the Mask Test counter is reset when the horizontal scale 

value is changed in Infiniium Magneto. 

- Solve the Write Eye Diagram issues where some of the start burst of the DQS signal after 

filtered is wrong.  

 

Agilent N6462A Software Version 01.10 

Release Date: May 30, 2014 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

4.60 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

4.60 (9000 Series) 

File Name: SetupInfDDR401100000.exe 

License: Please see the product data sheet on Keysight.com 

 

Enhancements 

- Supports for Infiniium Oscilloscope Software version 5.00. 

- Updated tQHS test due to the test definition was changed. 

 

Agilent N6462A Software Version 01.02 

Release Date: May 06, 2014 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

3.11 (90000 Series, 90000 X-Series), 

3.11 (9000 Series) 

File Name: SetupInfDDR401020000.exe 

License: Please see the product data sheet on Keysight.com 

 

Miscellaneous Notes 

- This will be the last version to support Infiniium Oscilloscope Baseline Version 4.20. 
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New Features 

- Added DDR4 Lynx Eye Diagram support. 

- Added DDR4 debug tool and offline setup gui. 

- Added HDF5 (*.h5) file format support for compliance app, offline mode and debug tool. 

- Added Sampling Point configuration for Lynx Eye Diagram. 

- Added tCKE test limit. 

- Added VIX(CK) test. 

- Added Vcent configuration for user defined Vcent level. 

- Added Vcent reporting for tDIVW and vDIVW tests. 

 

Modifications 

- Solved issue where digital only connect to DIGital8 to DIGital15 only. 

- Solved index out of range which due to incomplete last burst. 

- Solved issue that happens when DQS amplitude is small. 

- Solved eye diagram defect for vDIVW test. 

 

Enhancements 

- HTML Report “User Comments” field now preserves line breaks. 

- InfiniiSim now includes new Delay option. 

- New option to control jump behavior when you double-click a test name on the Select 

Tests tab. See View > Preferences > Report. 

- Remote Interface updated to version 2.50. 

- InfiniiSim now includes new Normalize Gain option. 

- Fixed Connection tab "Suppress" checkbox. 

- When using BitifEye BIT2100 instrument for switch matrix, now requires minimum firmware 

version: 3.4-1.10. 

- Updated DDR4 specification JESD79-4. 

 

Agilent N6462A Software Version 01.01 

Release Date: July 22, 2013 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 
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Requirements category (e.g., minimum instrument 

software version): 

3.11 (90000 Series, 90000 X-Series), 

3.11 (9000 Series) 

File Name: SetupInfDDR401010000.exe 

License: Please see the product data sheet on Keysight.com 

Enhancements 

- Support for MSOX90000. 

 

Agilent N6462A Software Version 01.00.0001 

Release Date: Aug 28, 2012 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

3.11 (90000 Series, 90000 X-Series), 

3.11 (9000 Series) 

File Name: SetupInfDDR401000001.exe 

License: Please see the product data sheet on Keysight.com 

 

Modifications 

- Fixed installation issue. 

Agilent N6462A Software Version 01.00 

Release Date: August 17, 2012 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., minimum instrument 

software version): 

3.11 (90000 Series, 90000 X-Series), 

3.11 (9000 Series) 

File Name: SetupInfDDR401000000.exe 

License: Please see the product data sheet on Keysight.com 

Initial Release 
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